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Station Plus -  Quick Start  Guide 

Opening a project 

About the Demo Project 
The demo project is a 48tk project that contains audio and video to accompany this guide and get you 
started with Dream II. 

Opening the Demo Project 
Launch Dream II.  

Press the Project button located on the right of your console.  

 

Project Key 

Locate the Demo Project on the audio drive that you chose when you installed it.  Using the soft keys, 
press {Open} to launch the project manager dialogue box. 

Select ‘Demo.MT’ and click OK to open. 

The demo project should now be open.   This project contains both mono and stereo clips.  Mono clips 
are contained on tracks 1 to 4.  Stereo clips are contained on tracks 5 to 28.  Stereo clips occupy two 
tracks and are indicated by a coloured link symbol. 

Setting up your surface 

Patching Main Control Room Monitors 

Step 1 Hold down the BLUE key and press the Monitor Setup key.   
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Monitor 
Setup Key 

 

Step 2 Press the {Patch Outputs} soft key. 

Step 3 Press the {Main} soft key. 

Step 5 Press the {Format} soft key to cycle through and select the format of the main speaker set. 
Notice that the Speaker Mute keys light to show which surround speakers are active. 

 

Speaker Mute keys showing 
that the format is LCRS. 

The Left speaker is 
highlighted, showing that 
Left is selected for output 
patching. 

Step 6 If you wish, change the type of physical output from analog, by pressing the {ANALOG/DIGITAL} 
and if necessary the {AES/MADI} soft keys, or using the choices on the Channel Select panel of 
the Mixer Screen. 

Step 7 Select the output for the first speaker. This can be done on the track keys (which represent 
outputs during this activity) or using the mouse on the Mixer Screen. 
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The bottom right of the Mixer Screen will display your choice, and your stage in the process. 

 

Step 7 Press the {Next} soft key to move to the next speaker in the set, and repeat until all speakers 
have been given outputs. You could also choose the next speaker using the Speaker mute 
buttons. 

Step 8 Press the {End} soft key upon completion of patching. 

Main bus format 

Step 1 Press the BLUE-Format button on the console. 

 

Format button – use BLUE 
key. 

Main button (same but 
without BLUE) 

Step 2 Press the Main button on the console. The possible main bus formats are displayed on the LCD 
screen. 

Step 3 Using the soft keys, select the desired format for the main bus. 

Step 4 Press the BLUE-Format button again, or any other mode key, to exit the Format menu. 
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Playing audio 
Now it’s time to play some audio.  

Call a Channel 
Click on the Mixer Screen to call a channel to the Master fader. 

Master Fader 
You can use the Master Fader to adjust the level of the called channel. 

On-Screen Faders 
You can also use the on-screen faders, as follows: 

Step 1 Click on a fader in the Mixer Screen, and hold the mouse down. 

The mouse jumps down (if the fader is closed) near the bottom of the screen. 

 

Click on fader and 
drag it to change 
level 

Step 2 Drag the mouse upwards, and you’ll see the fader rise as well, but slowly. 

The mouse is “geared” high so that you can set fader values accurately. 

Look at the “Fat Channel” below. The channel you clicked has been “called” to the Fat Channel, 
and the fader mirrors the movements you are making. You can also see an accurate numerical 
fader value. 

It’s also possible to set multiple faders at the same time: 

Step 1 Click on the numbers of several channels. They will go red – this is called a Multi-Trim group. 

Step 2 Click and drag the fader of a channel whose number is selected, and all Multi-Trim faders will 
move relatively i.e. by the same percentage. You can also force them all to have the same value 
by control-dragging one of the faders – the others will instantly adopt the same value. 

Step 3 You can add or subtract members from the Multi-Trim group at any time. While it is active you 
can also change fader levels for other individual channels that are not in this group. 
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Set Screen Fader to unity 

Step 1 Double-click the Master fader. This will set it to unity (0 dB). The same applies to any other 
fader. 

Set Master Fader to unity 

Step 1 Hold down the Blue key and touch the Master fader. This will set it to unity (0 dB).  

Control Monitor Level 
Use the Monitor pot to control level. 

Use the Monitor Mute button to silence the monitors. 

Use the Monitor Dim button to lower the volume level, as follows: 

Step 1 Hold down the Dim key and turn the Jogger Wheel. You will see the Dim level in the LCD display.  

Step 2 Release the Dim key to adopt that level. 

Step 3 Toggle Dim on and off with the Dim key, and use Step 1 to change the Dim level. 

View the Video Track 
The demo project also contains a video track which is displayed as the first track in Dream II.  (Note: the 
video track is separate from track feeds, and does not replace Track 1).   

To view the video, open View >View Pyxis from the toolbar on your Dream II Editor screen.  You should 
now be able to view the video as well as hear audio.  (Note: you need to obtain a Pyxis license if you 
want to enable this feature). 

Transport 
The Play, Stop, FF, and Rew controls work in a similar manner to a tape machine.  You can also 
increase the fast-forward and rewind speeds by pressing their buttons again, up to six times. 

Shuttle 

To shuttle the transport, hold down the BLUE key and press Jog/Shut.  The jogger wheel will then 
increase and decrease the transport velocity in forward and reverse.  

If you hold down the BLUE key and press Jog/Shut while the transport is in Play, the system will enter 
Shuttle at play speed. 

If you press the REW key while shuttling forward, the system will reverse direction, maintaining the same 
speed. Similarly if you press the FF key while shuttling backwards. 

Jump 

The Jump keys provide a fast method of locating forwards and backwards through a project.  The Jump 
keys are located on the Binnacle, left and right of the Play/Jog key.   

Mouse 

Holding down the right mouse key and moving the mousewill also move the transport, but no sound will 
be heard.   
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Locator Functions 

Rapid navigation through the project is achieved by making marks on the time-line.  To create a mark, 
locate the transport to the desired point and press the Mark button.  Marks are shown as yellow 
indicators on the timescale in the Dream II Editor display. 

 

Mark Button 

Marks can be named, or moved by entering a timecode. To do this: 

Step 1 Create a mark using the Mark button on the console. 

Step 2 Press BLUE-Mark, or select View>Locators in the Edit Screen. The Edit Marks dialog is shown: 

 

Click Rename 

Click on the   
mark you want 
to name 

Step 3 To name a mark, select it, then click the Rename button and fill in your desired name.   

Step 4 Press ENTER. 

Track Display 
Select the number of tracks to display on the Dream II Editor display by holding down the BLUE key, and 
pressing one of the numeric keys labelled 1T, 2T, 4T, 8T, 16T, 24T, 32T and 48T.  
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Track Display 
Keys 

Zoom 

To zoom: 

Step 1 Hold down the Zoom Binnacle key. 

Step 2 Turn the jogger wheel to zoom in and out. 

If your mouse has a wheel, it can also be used to zoom in and out. 

Grouping 
Link groups allow the control of up to eight feeds with one fader.  When a link group is created, the 
number of members determines the format of the link group.   

For example, to create a stereo link group on tracks 5 & 6: 

Step 1 Press the BLUE-Group key 

 

Group 

K

Step 2 Press the feed selection key of the first feed of the group (track 5). 

Step 3 Press the feed selection key of the last feed of the group (track 6). 
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Step 4 Select the {all defaults} soft key.  

This will apply pan settings to each member of the link group in the specified format (in this case, L & R).  
For example, if tracks 1 to 6 were linked they would be panned L: C: R: LS: RS: B.  

All defaults also applies the track feed parameter values of the first member of the group to all the 
members (these are fader level, pan, EQ, dynamics, aux sends, inserts and direct out state). 

Step 5 Press the BLUE-Group key again, or any other mode key (Cut, Copy etc), to complete the 
operation.  

To destroy a link group: 

Step 1 Press the BLUE-Group key.  The feeds that currently belong to a link group flash red. 

Step 2 Press the feed selection key of a feed belonging to a group. 

Step 3 Select {unlink} in the LCD soft key menu. 

Step 4 Press the BLUE-Group key again, or any other mode key (Cut, Copy etc), to complete the 
operation. 

Console Mixing Functions 
The Console provides the Parameter Pad for control of signal processing by channel. 

Calling a Channel 
To use the Parameter Pad, you must Call a channel, by one of the following methods: 

1. Click a “tile” on the mixing screen. 

2. Press the CALL button and choose a channel on the Track Keys. 

Using the PLUS key 

Pressing the PLUS button allows you to place other path types on the Track keys.  

 

PLUS key 
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Use the LIVES & PLUS KEYS section to do this. 

 

Use when PLUS key is 
lit to put Lives, MT 
buses or Ext channels 
on the Track Keys 

Using the Parameter Pad 

 

Once a signal path is on the Parameter Pad, you can control its fundamental signal processing with real 
time controls. 

EQ 

Step 1 Call a channel to the Parameter Pad as described above. 
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Step 2 Press the EQ button below the Parameter Pad. 

Step 3 Use the controls as described briefly below: 

 

Controls 
for Band 1 

Sets EQ level 
compensation  

Controls 
for Band 4 

Controls 
for Band 3 

Controls 
for Band 2 

Click to switch 
from EQ to Filter 
control 

Click to control 
band pass type and 
frequency range 

Click to toggle 
between Frequency 
control and Q 
control on the pot

Click to turn EQ 
off, without 
changing its 
parameters
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Filters 

 

Click to switch 
from EQ to Filter 
control 

Controls for 
Lo Pass/High 
Shelf 

Controls for 
Hi Pass/Low 
Shelf 

Click to enter Setup 
mode, where filters 
can be toggled with 
high and low shelves 

Click to turn EQ 
off, without 
changing its 
parameters

Sets EQ level 
compensation  
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Pan 

 

Controls 
for Boom 
send 

Left Right 
Pan 

Controls 
for 
Panning 

Boom Pre/Post 

Pan On Off 

Click to toggle between 
1D divergence (left and 
right only) and 2D 
divergence (LR and FB) 

Front Back 
Pan 

NOTE: Spread can be used only for Link Groups. 

Rotation can be used only with surround mix formats i.e. those with surround speakers. It rotates 
the position of a channel or group in the surround space – this can be seen most clearly in the 
Fat Channel display at the bottom of the Mixer Screen. 

Dyanamics 

Pressing the DYN button brings up the dynamics display. It is divided into two halves vertically.  

The left half always controls the Compressor section. 

The right half may be switched between Gate, Expander and Limiter. NOTE: Each channel may have a 
Compressor, plus a Limiter, plus a choice of Expander or Gate. 
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Compressor      Expander 

 

Click to switch 
the control 
below between 
Hold time and 
Release time 

Sets Makeup 
gain for whole 
dynamics block  

Controls Hold 
time or 
Release time 

Click to switch 
between Feed 
Forward and 
Feed Back 

Click to switch right 
hand controls between 
Expander, Gate and 
Limiter 

Click to switch the 
control below between 
Hold time and Release 
time 

Controls Hold time 
or Release time 

Click to switch the 
control above from 
Threshold to Ratio 
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Aux 

 

Controls 
for Aux 1 

Controls 
for Aux 3 

Controls 
for Aux 2 

Controls 
for Aux 4 

Plug-ins 

Plug-ins are controlled by the manufacturers’ on-screen displays. 

Screen Mixing Functions 
All mixing functions can be done with the mouse. A group of these functions can be done directly on the 
Mixer Screen, as shown below. 
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All other functions are controlled using the DREAM II Virtual Channel, shown below. 

 

• To open the DREAM II Virtual Channel, right click on a channel “tile” in the Mixing Screen. In the 
above example, we have right clicked Track 8. 

• To close the Virtual Channel, right click anywhere inside it. 

• While it is open, you may move to the next or previous channel by clicking the + and – buttons 
next to the channel name. 

Fader Control 

Solo ON / OFF 

Mute ON / OFF 

Dynamics In (indicator only – appears 
when any dynamics present) 

Insert IN / OUT 

EQ IN / OUT 

Click here to 
cycle the 
display 
between Pan, 
EQ and Dyn 

Click here to 
add this channel 
to the Multi-
Trim group (the 
number goes 
red) 
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Click to select next or 
previous channel 

Panning 
Dream II supported surround formats are: Stereo; LCRS, LCRSS; 5.1; 6.1; and 7.1.   

 

Panning IN / OUT 

Boom send ON / 
OFF 

While operating the pan controls, the Fat Channel gives a visual representation of the pan position and 
divergence. A complex example is shown below. 

 

Panning of 4-way Link Group 
showing Rotation and 
Divergence 

Basic Panning 

Use the L-R and F-B controls for basic panning. If the Main Bus format does not have surround channels, 
the F-B control will still be shown, but will do nothing. 
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Spread 

Only available when a link group is selected.  The spread control adjusts the perceived size of a surround 
mix. 

Diverge 

Spreads the signal of an individual feed across more of the adjacent loudspeakers, making the perceived 
size of the sound source larger. 

Rotate 

Rotate controls the left/right and front/back pan control to rotate the surround mix around the centre of 
the room. 

Using the panner: 

Step 1 Call a signal path to the channel panel by pressing the Call button on any fader.  

Step 2 Adjust the control to achieve the desired result.  The parameter values are displayed in the fat 
channel section at the bottom of the mixer display. 

Boom 

Sending level to the Boom channel can be done pre or post fader. 
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Equalisation 

 

Lo-Pass Filter 

Parametric EQ 
(bandpass) 

Hi-Pass Filter 

Gain Compensation 

EQ IN / OUT 

The track feed mixer EQ provides four bands of parametric equalization and two filters.  Each parametric 
section can be switched in or out independently. 

The Gain controls in the Filter sections have no function. The 2X controls double the slope of the filters, 
from 12 to 24 dB / octave. 
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Dynamics 
The Dream II Dynamics comprises three sections, compressor, limiter, and expander or gate. 

 

Make-up gain 

Gate/Expander IN / OUT 

Limiter IN / OUT 

Compressor IN / OUT 

Each section has an independent IN / OUT control. All three may be active at the same time if required. 

The Fat Channel shows the transfer function of the dynamics control, plus gain reduction metering. 
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Aux Sends 
Satellite-AV provides 12 aux sends. Each send from each channel has an independent Pre/Post switch 
and In/Out control. 

 

Aux 2 send IN / OUT 
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Editing Basics 

Cut and Paste Editing 
The edit modes are selected on the outer ring of the binnacle keys.  These modes are cut, copy, erase, 
trim / slip, and fade.  To perform cut and paste editing. 

Step 1 Select one or more tracks using the channel selection keys.  Selected track numbers are 
highlighted in blue on the Dream II Editor screen. 

Step 2 Press the Cut key on the binnacle to enter Cut mode. 

Step 3 Make sure the Range ON key is OFF. 

Step 4 Locate the transport so the cursor lies over the desired edit point.  Clips that are selected for 
editing are pink.  Unselected clips are blue. 

 

Step 5 Press down an “edit target” key (Clip, Head or Tail) on the left hand side of the binnacle. The 
thing you pressed is cut and placed on the clipboard. 

Step 6 Locate the transport so the cursor lies over the destination edit point.  If required, select 
alternative destination tracks using the track selection keys.   

Step 7 Press the ENTER key to paste the clip(s) on the clipboard. 

Copy and paste is the same, except you select the Copy mode key on the Binnacle. 

Using a range, you can cut and paste regions in the middle of clips. The method is similar – you must 
create your range (see later), and you must press the Range target key. Ranges are discussed later. 

Trimming Clips 
Trimming a clip means exposing more or less of the original recording in that clip. 

Step 1 Select one or more tracks using the channel selection keys.  Selected track numbers are 
highlighted in blue on the Dream II Editor screen. 

Step 2 Press the Trim key on the binnacle to enter Trim mode. 
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Step 3 Press the Head or Tail target key. This shortens the clip to the current transport position. 

Step 4 If you want to refine the trim position further, move the transport to the position where you want 
the clip to end, and press ENTER. 

Super Trim 

This allows you to see and hear the full extent of the clip while trimming it. 

Step 1 As before – select one or more tracks using the channel selection keys.  Selected track numbers 
are highlighted in blue on the Dream II Editor screen. 

Step 2 As before – press the Trim key on the binnacle to enter Trim mode. 

Step 3 Hold Down the Head or Tail target key. This lengthens the clip to its full extent. 

Step 4 While continuing to hold down the key, move the transport to the position where you would like 
the clip to end. 

Step 5 Release the target key, and the clip will be trimmed to the current transport position. 

Fades 

Simple Fades 

To create a simple fade: 

Step 1 Select a track and move a clip under the cursor. 

Step 2 Press the Binnacle Fade button. 

Step 3 Make sure there is no range (press the Range ON button if illuminated). 

Step 4 Press the Head button. 

This will create a fade from the start of the clip to the cursor position. The shape of the fade will follow 
the graph shown in the Head region of the Fade display, shown below. 
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Head Duration value 

Head Shape values 

Head Shape graph 

 

You can change the shape by dragging the red Crossover indicator with the mouse, then reapplying the 
fade. You can also enter the shape values numerically by clicking in their fields. 

Pressing Tail in step 4 would create a fade from the cursor to the end of the clip. 

Pressing Clip in step 4 would apply the numerical Duration values to both ends of the clip (see Advanced 
Fades below). 

Advanced Fades 

In the Simple Fades section above, the length of the fade was determined by the clip’s position relative to 
the cursor. 

In Advanced Fades we will set the lengths of fades numerically. 

Fade lengths are set numerically when: 

3. Fade Clip is used (press the Clip button instead of Head or Tail) 

4. There is a range (press Head, Tail or Clip). The results are applied to all clips that are wholly 
within the range. 

5. When the Set Dur or Trim Dur commands are used. 

Choosing What is Set 

In all fade commands, you can choose to set only the fade length (uncheck Shape) or only the shape 
(uncheck Length). By default both boxes are checked. 

 

The Clip, Head and Tail buttons do the 
same as their Binnacle equivalents 

Length and Shape checkboxes 

Setting Fade Duration Numerically 

Step 1 Press the {set dur} soft key.  
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Step 2 Choose Head, Tail or Clip to determine which end(s) of the clip is being affected. 

Step 3 Use the jogger wheel or Numeric Keypad to enter a fade length. 

Step 4 Press ENTER to apply the fade. If Shape is checked, it will also be applied. 

If a range is present, this command will apply to all clips that are wholly within the range. 

Trimming Fade Duration 

Press the {trim dur} soft key and use the jogger wheel to enter a positive or negative value. Deselect 
the {Shape} soft key if you do not wish to apply the current fade shape to the selected clips. 

Press the Binnacle Clip, Head or Tail key to increase or decrease the length of fades by the specified 
amount. Pressing the Clip key affects fades at both the Head and Tail of each selected (red) clip, while 
pressing Head affects only fades at the head and Tail affects only fades at the tail. 

Step 1 Press the {trim dur} soft key 

Step 2 Choose Head, Tail or Clip to determine which end(s) of the clip is being affected. 

Step 3 Use the jogger wheel or Numeric Keypad to enter a fade length trim.  

This will be shown as <+ something> or <– something> in the display. 

Step 4 Press ENTER to apply the trim. If Shape is checked, it will also be applied. 

If a range is present, this command will apply to all clips that are wholly within the range. 

Adjusting Fade Shape 

Press the {X-Level} soft key and use the jogger wheel to adjust the X-Level and/or press the {X-
Point} soft key and use the jogger wheel to adjust the X-Point. You can also change the values 
numerically on the screen, or by dragging the red crossover point with the mouse. 

The shape is used whenever a fade is applied, if the Shape box is checked. 

Capturing Fade Shapes 

Press the {Capture} soft key plus the Binnacle Clip, Head or Tail key to capture the fade shape from 
the current clip. The current clip is the clip currently touching the playhead on the active track.  

Deleting Fades 

Press the {delete} soft key, then press the Binnacle Clip, Head or Tail key to delete one or both ends 
of the fades.  

Presets 

A preset is a saved shape for head and tail. Factory presets are provided for your use. Custom presets 
are saved by you. 

To load a factory preset, press the {Preset} soft key, then press keys 1-9 on the numeric keypad to 
choose one of the 9 factory fade presets. The preset is loaded into the Shape graphs, and can be applied 
to clips in the usual way. Alternatively, click a number in the preset pad at the left of the display. 
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Click to load a factory preset 

To load a custom preset: 

Step 1 Press the {preset} soft key 

Step 2 Press {custom preset}. 

Step 3 Turn the Jogger Wheel, and as each custom preset is displayed it is also loaded. Stop when you 
have loaded the one you want. 

Alternatively use the custom presets pulldown menu in the Fades display. 

 

Click to load a custom preset 

Click to type a new name for a 
custom preset, then click Save 

To save a custom preset: 

Step 1 Set up the fade shapes you want to save. 

Step 2 Press the {preset} soft key 

Step 3 Press {save preset}. 

Step 4 Type a name for the new custom preset and press the Binnacle Enter key. 

Alternatively use the custom presets pulldown menu in the Fades display, as shown above. 

About Range 
A range allows a group of clips across one or multiple tracks to be selected.  Range may be turned on or 
off using the Range ON key, to the right of the Binnacle.  Double pressing a Binnacle edit key always 
clears the range.  

To select a Range: 
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Step 1 Locate to the time at which you wish to start the range. 

Step 2 Press the From key located on the left of the jogger wheel 

Step 3 Locate to the time at which you wish to end the range. 

Step 4 Press the To key located on the right of the jogger wheel. 

** Note: You can also select or deselect clips by CTRL-Clicking them with the mouse. If you CTRL-Click a 
clip outside the current Range, the range boundaries are extended. 

 

 

Clip-Based Equalisation 
The Dream II console provides both track EQ in the mixer, and clip based EQ in the editor. 

Applying Clip Based EQ 
Clip EQ provides clip based, four band parametric equalization which can be applied to a single clip or 
range of clips within a project.   

To apply clip based EQ: 

Step 1 Select the track that contains the target clip for equalization. 

Step 2 Move the target clip under the play head so that it goes pink.  

Step 3 Press the EQ button located on the editor panel.  The Smartpane on the Dream II screen will 
now appear. 
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EQ key 

Step 4 Press the {Edit} soft key. 

Step 5 Select the appropriate EQ parameters and set their values.   

Step 7 Click on the {old/new} soft keys if you want compare your new settings with the current setting 
for the clip.  

Step 8 Press the {Apply} soft key or the Binnacle Enter key to apply the fade. 

EQ In/Out 

Click on the {in/out} soft key at any time to toggle clip equalization on and off for the red clip(s).  

Copy EQ Between Clips 

Click on the {in/out} soft key at any time to toggle clip equalization on and off for the red clip(s).  

Step 1 Select the track that contains the clip to be copied. 

Step 2 Move the target clip under the play head so that it goes pink.  

Step 3 Press the {copy} soft key 

Step 4 Locate the target clip under the cursor so that it goes pink. 

Step 5 Press the {apply} soft key to paste the EQ values into the new clip 

You can uncheck some of the bands if you don’t want to paste them (see below) 

Uncheck bands 
to avoid 
applying them 

After Copy – 
Graph is red 
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EQ With the Mouse 

All the EQ controls are duplicated on the screen, and can be operated with the mouse. 

 

In addition, the graph can be directly manipulated by dragging the red control points around the screen. 
This will update the Gain and Frequency fields (and cause changes in the sound). Q values can only be 
changed numerically. 

 

VST Plugins 

Setup and installation 

Step 1 Install your plugins as outlined by your plugin manufacturer.  The plugin will generate a file with 
extension ‘DLL’ in the folder that your plugin has been installed (most commonly located in 
C:\Program Files\VSTPlugins). 

Step 2 Copy the DLL file and paste into C:\Program Files\Fairlight\Dream II\Effects\VSTPlugins. 

Step 3 Restart the Dream II PC. 

Inserting a Plugin on a Track Feed 

Step 1 Call the track using the Call key located on the track fader. 

Step 2 Press the Insert Config key located on the top of the CAP panel.  The main LCD will now 
display the list of plugins that you have installed.   

Step 3 Using the jog wheel, scroll through the list of plug-ins on the main LCD screen (main LCD screen 
is located above the transport on the console). 

Step 4 When the desired plugin is displayed, press the {Add Plugin} soft key. The plugin popup will 
now appear on the Dream II Editor display.  Its fleximap will now be mapped to faders 1 to 12. 

Step 5 Press the Plugin key located on the top of the CAP panel to toggle the plugin popup and 
fleximap on/off.  

Step 6 To remove the plugin, press the {Remove Plugin} soft key located on the main LCD screen. 
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Rewire 

Launching a Rewire Application 
In order to patch a Rewire device, a Rewire application must be installed first (e.g. Reason, Ableton Live). 

Step 1 Click on ‘Setup’ in the Dream II toolbar. 

Step 2 Select ‘Setup Instruments’ to launch the dialogue box. Your Rewire application should appear in 
this list. 

Step 3 Click on the name of the desired Rewire application so it is highlighted. 

 

 

 

Step 4 Click on ‘Edit’ at the bottom of the dialogue box. Note: Some programs (eg – Reason) will launch 
automatically.  Others (eg - Ableton Live) need to be launched manually. 

Step 5 Open or create a project within your Rewire application (demo projects that accompany the 
application are a good starting point).    

Patching a Rewire Application 
Once your Rewire Application is launched, it’s time to patch Rewire inputs to track or live feeds.   

Step 1 Open the Patch I/O page by pressing the Patch I/O key on the channel panel. Click on 
Instrument Inputs located on the left hand side of the Patch I/O page. You see inputs labeled 
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according to the Rewire applications you have installed.  If you have installed more than one 
application, click ‘Page Down’ on the patch I/O page until you find the input for your Rewire 
application. Select the desired instrument input (e.g. If using Reason, select the inputs labeled 
Mix L and Mix R for a stereo mix). 

Step 2 Select Live Inputs located on the right hand side of the Patch I/O page.   

Step 3 Select Live Inputs 1 and 2. 

Step 4 Click Patch to complete the patch.   

 

You should now be able to hear a stereo signal generated by your Rewire application on Live 
feeds 1 and 

Step 5 Alternatively, you can patch instrument inputs to track feeds, but make sure the track is record 
enabled in order to hear your Rewire device (see Part 11 - Recording).  

Recording 
To record audio on a track, you must have an input patched to it.  This could be any signal source – in 
this case we will use an analog input. 

Step 1 Press the Patch I/O button on your console. 

Step 2 Click on Analog Inputs located on the left hand side of the patch I/O page. 

Step 3 Select four of the analog inputs. 
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Step 4 Select Track Inputs located on the bottom right hand side of the patch I/O page.  Select four 
tracks. 

Step 5 Click the Patch button to connect the four inputs to the four tracks. 

Step 6 Select the Arm key located on the editor panel.  The channel selection keys will now display red. 
NOTE: A track with no input patched cannot be Armed. 

 

Press the Arm 
key followed by a 
channel select 
button to arm 
tracks 

Step 6 Press the channel selection keys of the same four tracks.  They are now armed for recording.  
This is indicated by the red record enable indicators located on each track in the Dream II editor 
display. 

Step 7 Locate the transport to where you want to start recording, then press Play and Record 
together. 

Step 8 The recorded tracks will display red while recording. 

Step 9 Press Stop to cease recording. 

The Record Menu 
Some advanced recording functions can be accessed by holding down the Record button and choosing 
from the LCD Menu options: 

{head} Starts recording at the head of the clip under the cursor on the current (last-selected) track. If 
there is no clip under the cursor, starts at the next clip in a forwards direction. 

{clip} Same as {head} but recording drops out at the tail of the clip, so it covers the exact duration of 
that clip. 

{here} Recording starts exactly where the transport is located, but first it will preroll (see later). This 
allows you to find the exact punch-in point and the system will automatically punch in for you. 

{again} Repeats exactly the same recording you just made, dropping in and out where the last 
recording did. 

Preroll and Postroll are used in all the Record Menu functions. They are set on the ADR Menu: 
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Step 1 Press the ADR button on your console. 

 

ADR Button 

The screen displays a dialog box. 

 

Step 2 Click in the Preroll field at the right of the dialog and set a convenient value. 

Step 3 Click in the Postroll field and set a convenient value. 

Mixing Automation 

Creating a Simple Mix 

Step 1 Press the Mix ON key to enable mix automation. 

Step 2 Establish a basic static mix including fader levels, EQ, panning and dynamics.  These static 

Station Plus Page 38 
 



Quickstart Guide STATION PLUS - QUICK START GUIDE February 26, 2007 
 

settings are saved with the rest of the mix. 

Step 3 Press the Enable key. 

 

This opens a menu which allows selective enabling of mixer parameters for Write. Select 
{Faders} from the menu. 

Step 4 Press the Mix key to display the Mix menu.   

 

Press the {On STOP} soft key until Event is selected.  This determines what happens to the 
parameter value when you drop out of automation record by pressing the transport Stop key.  
The Event setting tells the mixer to hold the last recorded value until the next previously 
recorded event occurs.  If no events are encountered the parameter will remain at the same 
value until the end of the project.  

Step 5 Press the Auto key next to the Master fader you wish to control.  The Write indicator next to 
the fader will be illuminated. 

Step 6 Press Play and move the fader as required to adjust the balance.  
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Step 7 Press the transport Stop key to stop recording automation.  Notice that the fader indicator 
displays Read. 

Step 8 Rewind, press Play and audition the changes you have made.  Watch the fader move as it 
reproduces the moves you recorded.  

You can continue to add fader moves using the same method.  You can also use the Auto key to drop in 
and out of record over old mix data. 

Enable Pan, Mute or any other parameters in the Enable menu, and use the Auto key to enter record 
for these parameters as well. 

Saving and Loading Mixes 

To save a mix:  

Step 1 Press BLUE-File. 

 

Step 2 Press the {Save} soft key in the main LCD menu. 

Step 3 Click the trackball on the Mixer display to gain keyboard focus. 

Step 4 Type a unique name for the mix on the keyboard and press Enter. 

To load a mix: 

Step 1 Press BLUE-File. 

Step 2 Turn the jog wheel to scroll through the previously saved mixes (if any have been saved). They 
are shown in the vertically central section of the LCD display. 

Step 3 Press the {Load} soft key and the main LCD menu to load the selected mix. 

Step 4 Confirm by pressing the {Yes} or {No} soft key. 
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